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2 OVERVIEW OF THE XICATO GALAXI SYSTEM 

2.1 THE ROLES OF DEVICES AND SOFTWARE 

XICATO GALAXI DEVICES 

Xicato GalaXi devices (XIMs, XIDs, & 3rd party GalaXi powered devices) are intelligent lighting control 
components that are programmed to respond directly to inputs from sensors and switches. They 
don’t have to wait for instructions from controllers or gateways. In fact, there is no central controller 
in the Xicato GalaXi System – the nodes, collectively, are the control system. Distributing intelligence 
to the lights means that there is no single point of failure – a failed node affects only that node. 

SENSORS & SWITCHES 

In the GalaXi system, sensors are dumb. They do not tell the XIMs or XIDs what to do; they only 
provide raw input. Some Switches behave this way as well while others can be configured to be 
"smart”; they can send intensity or recall scene commands to configurable destinations. 

 

 

 

 

 

Each GalaXi node decides individually what to do in response to inputs from one or more sensors, 
switches, mobile devices, time clock, etc. These sensors and switches talk directly to the Xicato 
devices and do not pass through master controllers or gateways.  

  

 

 

“I detect motion.” 
 “The lux level is 50.”  “Button 1 was 

pressed.” 
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XICATO CONTROL PANEL 

The purpose of the Xicato Control Panel software is simply to program the GalaXi nodes. – to 
number them, name them, and tell them what to do in response to different inputs. It is the access 
point into the brains of the GalaXi devices.  

2.2 WHAT IS STORED IN GALAXI DEVICES VS THE CONTROL PANEL SOFTWARE 
 
Category Stored in GalaXi Node Stored in Control Panel 
Identification Secure Network encryption key 

Unique Device ID 
Device name 
Serial number 
Part number 
FW versions 

Secure Network names and associated 
encryption keys 

Groups Group membership numbers Group names and mapping to group numbers 
Scenes Scene membership numbers Scene names and mapping to scene numbers 
Sensors & 
Switches 

Rules about how to respond to 
sensor inputs 

 

Registry Intensity histogram 
Temperature histogram 
LED forward voltage 

Temporary storage of monitoring data as long 
as Control Panel remains open 

 “If Button 1 is pressed, I will recall scene 1.” 
“If motion is detected, I will dim to 80% intensity” 

“If the lux level is not 40, I will adjust intensity 
until the sensor sees 40 lux.” 
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2.3 PROVISIONING, NODES, RELAYS, AND GALAXI MESH NETWORKING 

Xicato is a member of the Bluetooth Special Interest Group (SIG), a contributing member of the 
Bluetooth Mesh Working Group, and is dedicated to Bluetooth SIG Mesh (SIGMesh) compliant 
products as soon as possible. However, at this time, Xicato Galaxi devices have not converted to 
SIGMesh compliancy and instead use the Xicato GalaXi Mesh (XMesh) protocol. This allows GalaXi 
devices to act as mesh nodes and relays once provisioned.   

Provisioning is a process of installing the device into a public or secure network and is a mandatory 
step for all GalaXi powered devices. In most instances, Galaxi devices are shipped from the factory 
un-provisioned. Provisioning is as simple as assigning the device a unique ID number or address. 
More information on assigning device IDs can be found in the Device IDs and Names section of this 
document.  

Within this user guide, you will also find mesh terminology referring to nodes and relays. A node is a 
provisioned device (i.e a device assigned a unique ID) and relays are nodes that are able to 
retransmit messages. Detailed information on configuring nodes into relays can be found in the 
Device Setup section of this guide.   
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3 INSTALLATION 

3.1 BEFORE YOU BEGIN 

Download the Xicato Control Panel from the Xicato ShareFile XIM Gen4 Tools support folder 

• Both PC and Mac versions are available. Please make sure to download the correct version 
for the system you are going to use. 

If you do not have access to the folder, send a request to: 

• Download@xicato.com with “Control Panel Support” in the subject line 
• In the support request, please make sure to provide your name and company. 
• Once you are signed up on the support site, you will be automatically informed of updates 

through the Xicato ShareFile system. 

Silicon Labs’ Bluegiga BLED112 Bluetooth Smart dongle (and associated driver) must 
be installed into an available USB port on your computer for the software to run.  
Your machine’s native Bluetooth interface is not used by the XIM Control Panel. The 
dongle provides a flexible, more consistent interface than native BLE interfaces on 
PCs and Macs. The dongle is available for purchase through many electronics 
distributors such as Digi-Key or Mouser. 

Digi-Key PN: 1446-1030-ND 
Mouser PN: 603-BLED112 

3.2 WINDOWS 

MINIMUM SYSTEM REQUIREMENTS 

• PC or Surface tablet with Intel Core i3 or later 
• 2 GB RAM 
• 100 MB free hard drive space 
• BlueGiga BLE USB dongle 
• Windows 7 OS or later 

BLED112 DRIVER DOWNLOAD & INSTALLATION 

Note: Manual installation of the BLED112 driver (below) is necessary for machines running Windows 
7. Windows 8 and later operating systems will auto detect the BLE dongle and install the appropriate 
drivers. 

1. Download the BLED112 driver from the Xicato ShareFile site.  
2. File will appear as a .zip file in your Downloads folder. 
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3. Right-click on the file and Extract it into the Downloads folder.  

 
4. Plug in the BlueGiga BLE Dongle. It may take a few re-insertions, or switching USB ports, for 

your PC to see it. 
5. Click Start Menu and right-click on Computer. 
6. Click Manage. 

 
7. Click Device Manager in left pane. 
8. In Device Manager window, expand categories and locate the dongle. If you have never 

installed the driver, the dongle will appear under “Other”.  

 
9. Right-click on the device name and select Update Driver Software… 
10. Click Browse my Computer for driver software. 
11. Click on Browse and navigate to the Downloads/BLED112…/windrv folder and click Okay. 
12. Click on Next button to install the driver. 
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XICATO CONTROL PANEL INSTALLATION 

1. Download the Xicato Control Panel Setup file from the Xicato ShareFile 
site. 

2. File will appear as a .exe file in your Downloads folder. 
3. Right-click on the file and select Open. 
4. Read and accept License Agreement. Click Next. 
5. Click Next to create desktop shortcut. 
6. Click Install to begin installation process. 
7. Select Finish to complete the installation. You may choose to view the Readme file or launch 

the Xicato Control Panel at this time. Note that the program will not work properly until the 
BLED112 Bluetooth® Smart USB dongle and drivers are installed on the machine. 
 

3.3 MACOS 

MINIMUM SYSTEM REQUIREMENTS 

• BlueGiga BLE USB Dongle 
• Core2Duo processor or later 
• macOS Sierra (version 10.12) or later 
• 4GB RAM and 100MB hard drive space 

XICATO CONTROL PANEL INSTALLATION 

1. Download the Xicato Control Panel Setup file from the Xicato ShareFile site. 

 
2. File will appear as a .dmg file in your Downloads folder. 
3. Double-click the DMG file and a window will appear with a link to your Applications folder. 
4. Drag the application icon to the Applications folder. 
5. The first time you open the Xicato Control Panel, you’ll see a warning. Agree to open the file.  

If the application does not start: 
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A. Go to System Preferences > Security & Privacy to tell your computer to open the 
application anyway (this is because our app is not signed yet). 

B. If the above option isn't presented to you, you will need to follow the steps below. 
1. Open Utilities in the Applications folder. 
2. Open up Terminal. 
3. Run 'sudo spctl --master-disable' (without the quotes) 
4. Open the Xicato Control Panel application.  
5. Run 'sudo spctl --master-enable' (again, without quotes). 

This should only need to happen the first time.  

3.4 INITIAL LAUNCH OF XICATO CONTROL PANEL 

When you first launch the Xicato Control Panel, you will be 
greeted with the Xicato splash screen followed by the 
Control Panel opening in Tablet View mode. If you would 
like to change this setting, navigate to Edit > Preferences in 
the main Menu Bar. 

 

Tablet View. Uncheck this box to disable Tablet View. In Tablet View, the 
contact size of controls is increased to improve convenience for tablet users. 
Disabling allows more content to be displayed.  

 

 

 

 

 

To change your preferred language setting, navigate to File > Language… in the main Menu Bar to 
open the Language Selection Screen. Language settings will apply after an application restart. 
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3.5 APPLICATION LAUNCH TROUBLESHOOTING 

The BlueGiga BLE dongle driver is not natively supported in Windows 7, and Windows sometimes 
does not recognize it. If you are having issues launching the Xicato Control Panel or if the application 
becomes unresponsive at the splash screen, there may be an issue with Windows communicating 
with the dongle. Follow these steps to correct the problem (note that these steps are not exclusive 
to Windows 7 and can be used for any operating system).  

 Check if there is another instance of the Xicato Control Panel already running. If so, close 
all instances and re-launch the Xicato Control Panel again. 

 Unplug your BLE dongle for a few seconds, then plug it back in and try re-launching 
Xicato Control Panel. 

 Unplug your BLE dongle and plug it into another USB port and try re-launching Control 
Panel.  
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4 DASHBOARD TAB 

The Dashboard appears after starting the Xicato Control Panel, and is the main window for 
monitoring all Xicato Bluetooth nodes in the space.  XIM and XID devices will be listed in the top 
portion of the dashboard screen while XIS sensors and relays (if any) will be listed below. 

 

4.1 POSITIONING THE WINDOWS 

The Lights, Sensors, and Switches and Relays windows can 
be floating or docked. To undock a window and make it a 
floating window, do one of the following: 

• Double-click the window’s title bar. 
• Drag a docked window by clicking its title bar. This 

action enables you to move the window to a 
different docked position or undock it.  

To dock a floating window: 

• Double-click the window’s title bar. 
• Drag the window to a docking location. 
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When you dock a window by dragging it, you can control its destination position. As 
you drag the window, you will see this docking icon appear. This icon shows where 
the window will be docked if you release the mouse button at that point.  

 

Dashboard Node Information Windows can be Resized and Rearranged 

If you move the mouse pointer to the border between two docked windows, the mouse pointer 
becomes an arrow. By dragging this arrow, you can resize the two adjacent windows and leave them 
in the docked state. 

4.2 NODE SELECTION TREE 

The Node Selection Tree is a window that displays a variety of hierarchical views of the nodes in the 
site. Users can expand and collapse container nodes by clicking the arrow expander icons. Nodes 
are organized by Secure Network and sorted in the tree by their device type (Lights, Sensors, Relays, 
etc). Light nodes (XIMs, XIDS, etc.) that are members of a group are also located in the Group’s 
parent folder. In the example below, the two nodes named Tiberius Gracchus and Gaius Gracchus 
are located in two node tree locations:  

1. Forum/Unsecured/All Nodes/Lights 
2. Forum/Unsecured/Romans (ID 2525)/Lights 
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The brackets [ ] beside each container label displays the quantity of nodes within the container.  
Group and Device IDs are displayed in parentheses ( ) next to the Group or Node name, respectively.   

Right-clicking certain containers in the Node Selection Tree allows users to access additional 
commands directly from the tree. Right-clicking a light shows the Indicate, 0%, 1%, 10%, 50%, 100% 
options. Right-clicking "Lights" will broadcast the selected intensity. Right-clicking a group also shows 
the Modify, Remove options in addition to the intensity options. Right-clicking a network shows the 
Modify, Remove options. 

The top-most root container is the Site name. The Site is the configuration file that contains 
information for all of the networks. Each network has its own set of groups and scenes names that 
are stored in the Site configuration file. The option to save or load a Site configuration file is located 
in the File menu of the menu bar. Selecting New Site from the drop down menu will clear all Secure 
Networks and Group/Scene names from the current Node Selection Tree.  

 

Beneath the Node Selection Tree is a search field for entering free text. If the user enters a term in 
the Find field and triggers the search by pressing Enter, the tree will find and highlight the next node 
in the tree, which contains the corresponding value.  



 

©Xicato Inc. Xicato Control Panel User Manual                               
September 2018    16 

 

Checkboxes beside each container or node in the tree controls which nodes are displayed on the 
Dashboard screen. Checking or unchecking a parent container of the tree will select all or clear all 
nodes. A mixed-state check box indicates partial selection of the nodes in the container.  

 

4.3 NODE FILTER 

Filters nodes in the Node Selection Tree based on the criteria displayed in this section. 

Timeout(s). If a node’s advertisement hasn’t been received within this window (in seconds), 
then the device will be removed. Press Enter to set the new value, which must be 0 (no 
timeout) or greater than or equal to 60. If blank, then the currently stored value will display. 
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RSSI Min (dBm). Minimum received signal strength (in dBm).  Press Enter to set the new 
value, which must be between -127 to 0 or blank. If blank, then the currently stored value will 
display. Click Stop Scanning then Start Scanning to refresh the list.  

Show Repeated. Enable/Disable showing repeated packets.  

4.4 SELECTING NODE INFORMATION TO SHOW/HIDE 

Each column of the Lights, Sensors, and Switches and Relays information windows can be toggled so 
that they are either displayed or hidden. Right-click any of the column headers to display a menu of 
available columns to select from. 

 

4.5 NETWORK 

The Network column displays the name of the Secure Network the device is a member of. 

Before assigning a device to a Secure Network, a Secure Network must first be created or a Secure 
Network list must be imported into the Control Panel.  See Secure Network Management section 
of this document for more information. Only provisioned nodes (Assigned Devices) may be allocated 
to Secure Networks. 

To assign the Secure Network a node is on, start by clicking the field to open the drop-down menu, 
which contains a list of all available Networks. Then select the desired network. Click Send Updates 
to program the new Secure Network to the selected device.  

 

To quickly assign the same Secure Network to multiple nodes in the Dashboard, hold down the shift 
key and highlight all devices in the Dashboard you wish to modify. Right-click the Secure Network 
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and select Fill Down from the menu. The highlighted devices will then match the top selected 
Secure Network. Click Send Updates to program the Secure Network to the selected devices. 

 

4.6 DEVICE ID AND NAMES 

The Device ID column displays the address of each device. The default address from the factory is in 
a 3-byte format (xxx.xxx.xxx). Addresses are considered unprovisioned Unassigned Devices in this 
format and their cells are highlighted in yellow indicating that the device has an unassigned ID and is 
waiting for the user to assign it a proper Assigned address. The device will become a provisioned 
node once the device is assigned an ID address. An Assigned address is a single integer between 1 
and 32767. Assigned addresses must be unique and no two nodes can share the same Assigned 
address within the same Secure Network.  Although it is not required, Xicato strongly suggests 
utilizing a taxonomy system when defining ID numbers. (e.g., lights are assigned IDs from 1 to 9999, 
sensors from 16000 to 23999 and 24000 to 32767 for interface nodes (XIGs, Control Panel, etc.)).    

 

Example of an Unassigned and Assigned Device IDs 

Assigning a device a proper Device ID should be the first task a user completes when introducing a 
new node into the network. A previously Assigned address can also be changed to an Unassigned 
address if needed. Moving a node from an Assigned address to an Unassigned address will restore 
the device back to its factory configuration by clearing all network security, groups and scenes.  

The Name column displays the descriptive name of each Device. The default name is identical to the 
Device name. Like the Device ID column, this field is directly editable and can be changed to any text 
the user wishes. Unlike Device ID, however, the Name of the device does not need to be unique. 
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Duplicate Names are acceptable but Device IDs must be unique. 

To change the device ID address or name, click the cell and enter a new address or descriptive name. 
The cell background color will change to blue indicating that the value has changed but the new 
address or name has not been programmed into the device yet. To program the new values, click 
Send Updates (located on the bottom-left side of the Dashboard screen). A message will display 
confirming if the device was programmed successfully. To cancel the update of the device to a new 
device ID or name, click Clear Updates. 

 

When assigning Device ID to certain types of multi-channel devices, the master channel will be 
given the ID entered into the Device ID field. All sub-channels will automatically be assigned a 
Device ID in sequential order after the master channel. For example, if a 4 channel device is assigned 
a Device ID of 122, the master channel will be assigned to ID 122 and the 4 sub-channels will 
automatically be assigned IDs 123, 124, 125, & 126. It is best practice to verify all potential sub-
channel IDs are unassigned before assigning the master channel to prevent multiple devices sharing 
the same Device ID. 
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To quickly assign multiple Device IDs to nodes in the dashboard, hold down the shift key and 
highlight all devices in the Dashboard you wish to modify. Right-click the first Device ID and select 
Fill Down from the menu. The highlighted devices will then be auto assigned Device IDs in 
sequential order starting with the first Device ID in the list. Click Send Updates to program the new 
Device IDs to the selected devices. 

 

  

4.7 DEVICE INFO 

The Device column displays the part number of the node. Hover the mouse pointer over the device 
part number to display more information about the device such as firmware revision numbers, 
programmed flux values, and OEM programmed data.  
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Not all device information is broadcast continuously by the XIM. The user may have to double-click 
the device part number to issue a command to the device to send this data. This command can also 
be sent to all devices by clicking Get All Info located on the bottom panel of the Dashboard screen.   

  

4.8 INTENSITY AND LIGHT IDENTIFICATION 

The Intensity column displays the current percent intensity of the device. For XIM, the percentage is 
related to the maximum programmed flux value. A 1300lm XIM at 65% intensity will output roughly 
845lm. For XID, the percentage is related to the maximum programmed output current. A 700mA 
XID at 50% intensity will deliver 350mA to the connected light source. 

Double-click the intensity value to toggle the light between 0% and maximum intensity.    

Single-click the intensity value to identify or flash the selected light.  

Right-click the intensity value to pull up the Dim Level Control box. Use the mouse pointer to drag 
the slider to any intensity between 0-100%. When you release the slider, the device will dim to that 
level. You can also manually type in the desired intensity in the Intensity field. Press “Enter” on your 
keyboard to dim.  

When multiple users are commissioning a space, it is useful to have indicators unique to each user. 
Flash duration and frequency can be adjusted in the Indicate (Flash) Configuration section of the 
Preferences menu (Edit > Preferences).  

4.9 REAL TIME DATA 

The Dashboard tab displays some real time information about each device. For more detailed real 
time data collection, use the Log Tab. 

Power. Current power consumption of the device in Watts (W). 

Temp. Current temperature reading of the device in °C. 
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Vin. Input voltage (V) into the device. 

Hours. Operation hours of the device. Excludes time at 0% intensity.  

RSSI. Signal strength detected by the BluGiga Bluetooth dongle. Value is displayed in decibels above 
a reference level of one milliwatt (dBm). Devices with poor RSSI values may be filtered out of the 
Dashboard through the RSSI Min (dBm) field in the Filter section below the Node Selection tree. 
 

 
 

• RSSI less than -85dBM: Poor signal strength. Devices may be unresponsive to commands. 
• RSSI between -75 and -85dBm: OK signal strength. Devices are generally responsive to 

intensity change commands but retrieving data from the device may be challenging.  
• RSSI greater than -75dBm: Good signal strength. Devices are generally responsive to light 

intensity change commands, over-the-air updates, and programming new configuration 
settings. 

In a similar way to light, BLE radio waves travel in straight lines and are affected by obstructions 
(people, walls, objects) which can alter the signal. RSSI of any non-line-of-sight signal can vary rapidly 
as that signal encounters different media and interacts with different objects. Bluetooth signals will 
be reflected by some materials such as metal and stone and absorbed by water or any material that 
is porous and absorbs water. In both cases, the signal strength is reduced (attenuated) and must be 
taken into account when choosing fixture designs and their placement in an installation. 
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4.10 DEVICE STATUS

Status of each Device is displayed in the column.  

OK 

Indicates: 
1. the currently sampled LED Vf value is within its normal operating 

range 
2. the average Vin has not dropped below the under-voltage threshold. 
3. the LED is operating in its normal temperature range. 

UVO 
Under-Voltage. Indicates that the average Vin has gone to <38V and has not 
risen above the turn-on point of 40V.  For XID, these voltage thresholds may 
be different if re-configured by the OEM. 

UVL 

Under-Voltage Lockout. Indicates that the device has entered the under-
voltage state 5 times within 10 minutes.  When in this state, the LED intensity 
will be reduced to 0 (off). It will stay off until the device is powered down 
(<30V) or the intensity is commanded to 0%. 

TOV 

Thermal Overload. Indicates that the LED temperature has gone to ≥93°C 
and has not dropped below the temperature restore point of 85°C. When in 
this state, the LED intensity is reduced by 15% of the commanded intensity 
over a period of 60 seconds. Condition is cleared when the LED temperature 
goes below 85°C and the commanded intensity level is restored. 

TOL 
Thermal Overload Latch. Indicates that the device has been in Thermal 
Overload for > 10 minutes. When in this state, the LED intensity is limited to 
a maximum of 10%. 

TSD 
Thermal Shutdown. Indicates that the LED temperature has gone to ≥98°C. 
This condition is cleared when intensity is commanded to 0 (off), or the 
module is power cycled, and the LED temperature is <93°C.  

TCS 
Cold Start Protection. Indicates that the LED temperature has dropped 
below -20°C and has not gone above 0°C. This condition is cleared when the 
LED temperature goes above 0°C. 

TSF 
Temperature Sensor Failure. Indicates that the temperature sensor is no 
longer operating correctly.   When in this state, the LED intensity will be 
reduced to 0 (off).    

LOC LED Open Circuit. 
LSC LED Short Circuit. 
LCG Load Change. Vf is more than 5V higher or lower than the reference Vf. 
EM Emergency Lighting Mode. See Section 8.4 for more information. 

4.11 DALI 

DALI enabled XIMs hold two addresses: A 6 bit short address (0-63) which is used for operational 
access and a 24 bit random address (0-FFFFFF hex) which is used to assign the short address. 
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The process of generating and assigning both DALI addresses is administered by DALI commands 
transmitted from the DALI master. The DALI Short Address of an XIM is displayed in the DALI 
column of the dashboard.  

Non-DALI compatible XIMs and devices will display “N/A” in this field and DALI compatible XIMs will 
display “UNA” if the device has not been assigned a DALI Short Address by the DALI master.  

A yellow cell indicates a DALI bus failure.  

4.12 Tadv 

The Tadv column will show the advertising interval of the device. The advertising interval value 
displayed on the Dashboard will be the greater value of the following: 

• Time (seconds) between last two light status advertisements. 
• Time (seconds) since last receiving the last light status advertisement.  

4.13 SENSOR SPECIFIC COLUMNS 

The Sensors window of the Dashboard is reserved for XIS sensor data. Columns unique to Sensors 
include the motion, lux, and relative humidity values. The timer in the three Motion columns 
represents the time since a motion event was last received by the Control Panel. If no motion event 
was received or if no PIR sensor is connected to the XIS (up to 3 PIR sensors can be used with some 
sensor boards), the column will display “None”.  

The two Lux columns display the illuminance values measured on the XIS lux meter. If a 2nd lux 
meter is not connected to the XIS, the column will display “N/A”.  

The XIS’ onboard humidity sensor will report the percent relative humidity in the RH column. 

 

Double-click the XIS Device field to collect device information from the sensor. 
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5 DEVICE SETUP TAB 

  

5.1 FIRMWARE UPDATE 

HOW TO SEE THE CURRENT BLE FIRMWARE VERSION (FROM THE DASHBOARD TAB) 
 
From the Dashboard tab, hover over the Device field and see BLE FW Revision. 

 
 
XIS only: From the Dashboard tab, double-click the Device field and see BLE FW Revision. 
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WHAT CAN BE UPDATED 

• Modules with FW older than revision 0.097 cannot be updated Over the Air (OTA). They 
must be returned to Xicato to be updated through the physical wire interface. 

• XIM that are FW rev 0.097 or later can be OTA updated. Device ID must be a valid Assigned 
address, i.e. a unique, integer between 1 and 32767. 

UPDATE PROCESS 

1. Select the node to be updated in the Node Selection Tree. Multiple nodes can be updated in 
succession by selecting a group name or device parent container from the Node Selection 
Tree.  

2. Go to the Firmware Update panel and select the firmware revision from the Version drop 
down menu. If a group of devices are selected for FW updates, only the Newest FW version 
for each member of that group can be selected.  

3. Click the Update button. Application firmware updates should take about 1 minute per 
device to complete. 

4. Once the application update has completed successfully, the firmware update is complete. If 
a group was selected for updating, the next member of that group will then begin the 
update process. 
 

 

5.2 DEVICE BACKUP/RESTORE 

The Group, Scene, Beacon, Sensor, and Light Setup settings 
for any GalaXi device can be backed up using the Device 
Backup/ Restore panel. Backup files can be used to revert a  
device back to older settings or to clone a device based on 
the settings on another device. In order for the Backup/Restore function to work properly, it is 
important that the device to be restored shares the same part number and same BLE firmware as 
the device file to ensure that the update is successful since each BLE update typically includes new 
features that could create problems with the restore process if they don’t match. 

TO BACKUP A DEVICE 

1. Select and highlight the node from the Node Selection Tree. 
2. Click Backup… 
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3. Choose a location to place the Backup File and click Save. Default file name is 
Backup_[Network Name]_[Device ID].txt. You may choose to rename the file if you wish. 

TO RESTORE A DEVICE 

1. Select and highlight the node from the Node Selection Tree. 
2. Click the checkbox to enable the Set Device ID field if you would like the restored device to 

have a different Device ID from the backup file. This is important when cloning devices since 
all Device IDs must be unique in the Secure Network. The Set Device ID field will display a red 
background if the Device ID is already in use by another device.  

3. Click Restore… 
4. Navigate to the directory where the Backup file is located. 
5. Highlight Text file and click Open. 

The Xicato Control Panel will then connect to the selected device and reprogram its settings based 
on the Backup file configuration. 

5.3 COMMUNICATION  

Note: Modifying GalaXi communication settings may impact network performance. Xicato does not 
recommend adjusting default communication settings for most installations.  

Use this panel to configure how and when the individual device or selected group will broadcast 
their data stored within the device. Click Get to retrieve current communication configuration 
settings. Click Set to update configuration settings for the selected node(s). 

Tx Power (dBm). Use drop-down menu to select transmission power of the device’s BLE radio.  

Rx Gain. Use drop-down menu to select Normal or High receive gain for the device’s BLE antenna. 

Always Connectable. For normal operation, Always Connectable should be disabled. Enabling 
Always Connectable can impact device performance by BLE scanners trying to connect with the 
lights. The device may also become non-responsive since the device cannot receive messages while 
it is connected. Enabling Always Connectable should only be used as a debugging tool.  
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5.4 LONG TERM DATA ADVERTISEMENT 

Adjust the interval at which Long Term Data advertisement packets are transmitted. Long Term Data 
is device Information that does not change often or at all. Examples include: 

• Power and LED Cycles  
• Operation Hours 
• Product ID Code 
• Device Information  
• DALI address & status (if applicable) 

5.5 INTENSITY CHANGE ADVERTISEMENT 

Advertise information about transitions between LED intensity levels. These advertisements are only 
transmitted when intensity levels change.  This advertisement is primarily used when other lights are tracking a 
light's intensity. To reduce traffic, the burst count can be set to 0 if the light isn't being tracked.  

The data contained in the Intensity Change advertisement include: 

• Current intensity 
• Destination Intensity 
• Fade time remaining 

Burst Count is the number of times Intensity Change information is advertised when there is a 
change in a device’s intensity. Burst Interval is the time between burst advertisements.  

5.6 LIGHT STATUS ADVERTISMENT 

Use this section to configure how often Light Status data is broadcast. 
Light Status data is important device information that should be 
constantly monitored. It includes: 

• Intensity 
• Power 
• Tc and PCB Temperature 
• Supply Voltage and Ripple 
• Device Status 

Normal. Light Status data will be broadcast at this regularly set interval. 
Default is 10 seconds.  

Out of Range Trigger. When intensity, temperature, or input voltage is outside of the specified valid 
range, Light Status device data will broadcast at this interval. Default is 1 second. 
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Change Trigger. When intensity, temperature, or input voltage change by a specified value or 
percentage, broadcast Light Status data at this interval. Burst count is the number of advertisements 
sent. Default is 1 second. 

5.7 XIS CONFIGURATIONS 

MOTION ADVERTISEMENT 
Configure how often the sensor will broadcast information about motion. 

Motion Burst. Number of advertisements sent when motion is detected in absent mode. 

Motion Burst Interval (ms). Interval between burst advertisements. 

Motion Continue Interval (s). Interval between motion advertisements until timeout.  

Motion Timeout (s). Timeout to go into absent mode. 

Motion Absence Burst. Number of advertisements sent when absent mode is entered. 

ENVIRONMENT ADVERTISEMENT 
Configure interval in which the sensor will advertise temperature, relative humidity, and input 
voltage. Default is 5 seconds. 

LUX ADVERTISEMENT 
Configure how often the sensor will broadcast illuminance information. 

Base Interval (s). Interval in which the sensor will advertise lux 
data. 

Burst Count. Number of advertisements sent. 

Lux Delta Trigger (lux). If lux reading changes by entered value,  the sensor will broadcast 
the new lux value at the interval defined in the Lux Delta Interval (s) field.   

Input->ADV Slot. Select “Swap” from the drop down menu to swap the slot the lux value will 
be advertised on  (Lux 0 or Lux 1). If “Normal”, the selection is ignored and the device’s value 
will not change. 

Error Report Enable. When enabled, if the lux sensor reports an error, select whether it 
should be advertised or ignored for each input. When disabled, the selection is ignored and 
the device’s value will not change. 
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5.8 DEVICE RELAY AND MESH NETWORKING 

BASIC MESH OVERVIEW 

Xicato Galaxi devices can be configured to be relay nodes, i.e. nodes which are able to retransmit 
messages. This is used to extend networks by propagating messages to destination nodes outside 
the BLE radio transmission range of the source node. The Xicato GalaXi mesh network uses a flood 
technique where messages propogate along a path by hopping from node to node until it reaches 
its destination. Each relay node acts as both a transmitter and a reciever and each node tries to 
forward every message to every one of its neighbors. 

 

Flood mesh diagram courtesy of "Trends in Telecommunications Technologies” (intechopen.com) 

RELAY NODES 

It is important that all relay nodes are within radio range of their neighbors in order to forward 
messages. In the example below, messages can pass from node A to B through relay nodes (LE 1 
and LE 2), but cannot pass from node B to A. While Relay Node 1 can receive messages from Node A, 
the radio strength of relay node 1 is too weak to reach Node A. 
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TIME TO LIVE (TTL) 

Messages have a Time To Live (TTL) value. Its purpose is to control whether or not a received 
message should be relayed, and to limit the total number of hops over which a message is 
ultimately relayed within the network. Each time a message is received and retransmitted, TTL is 
decremented which limits the number of "hops". Every relay node that receives a network message 
with TTL ≥ 1 can retransmit it after decrementing the value by one using the formula TTLnew = 
TTLold-1.  

When a relay receives TTL = 1, it will re-transmit the message. A value of zero indicates that a 
message has not been relayed and should not be relayed. 

In the example below, messages from Node A need a starting TTL value ≥ 4 in order for that 
message to propagate successfully to Node B. Nodes also keep track of every message seen and 
only forward each message once. This prevents duplicate packets from circulating forever.   

 

TO CONFIGURE A RELAY NODE 

1. Select the node from the Node Selection Tree.  
2. Verify Repeat Enabled is checked in the View window. 
3. Click Get to retrieve current relay configuration settings.  
4. Select Enabled from the drop-down menu.  
5. Click Set to program the device as a relay node.  
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The node will now retransmit all received messages, depreciating the TTL by 1. If the received 
message has a TTL = 0, the message will not be retransmitted.   

TO CONFIGURE THE STARTING TTL OF DEVICES MESSAGES 

1. Select the node from the Node Selection Tree.  
2. Verify Starting TTL is checked in the View window.  
3. Click Get to retrieve current Starting TTL configuration settings.  
4. Enter the Starting TTL number in the text box. Starting TTL cannot exceed 7. 
5. Click Set to program the device as a relay node. 

 

In the example above, any message originating from this source will have a starting TTL value of 4. 
Any relay nodes within communication range will depreciate the TTL value by 1 and retransmit the 
message.  

Just like provisioned GalaXi lights and sensors, the Xicato Control Panel itself is a node and its 
broadcast messages can be assigned starting TTL values as well. Refer to the Local Network 
Settings section of this document for more details. 
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6 BEACONS TAB 

WHAT IS A BEACON? 

A BLE beacon is a short message that is advertised on a periodic basis from a Bluetooth device. It is 
like a lighthouse, constantly advertising its presence, without knowing how many ships are looking 
at it. It does not create a connection with a mobile device, but applications on the device – or web 
pages to which it points the user – can interpret the beacon to provide information or services to the 
user. BLE beacons are designed to provide services that are “location aware”, meaning that the 
information is relevant to the physical location of the user. This may work like GPS, providing a 
location on a map, or it may present information about something that the user is close to, such as a 
museum exhibit, merchandise on a retail shelf, a check-out counter, or a historical monument. 
Beacons can be used indoor or outdoor, but they have special value indoors, where GPS satellite 
signals do not penetrate, or in dense urban environments where GPS has problems with tall 
buildings. 

6.1 BEACON PROTOCOLS 

All GalaXi devices support the advertisement of three different BLE beacon protocols. 

EDDYSTONE CONFIGURATION  

Eddystone beacons are simply short URLs (Universal Resource Locator addresses… web addresses). 
They are designed to work with browsers, which must have an Internet connection to retrieve 
content or make meaning of the beacon.  

To broadcast an Eddystone beacon: 

1. Select a node from the Node Selection Tree.  
2. Verify Eddystone is checked in the View window under Beacon Configuration.  
3. Click Get to receive current configuration settings in the Eddystone Configuration Panel. 
4. Type in URI to broadcast. The URI is the web address to be advertised. To create a URI, use 

any URL shortner such as https://bitly.com. 

 

https://bitly.com/
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5. Select beacon transmission power (Tx Power) in the drop-down menu. 
6. Type in the broadcast interval in the Interval (ms) field. To disable beacon broadcasting, set 

the period to 0. 
7. Click Set to program the device to advertise the Eddystone beacon. 
8. Verify configuration was programmed successfully by clicking Get. Configuration settings 

should match the values you entered.  

For more information on Eddystone, visit https://developers.google.com/beacons/eddystone. 

 

IBEACON CONFIGURATION  

Apple iBeacon messages are constructed of a UUID, a major and a minor identifier. The UUID is 
specific to a beacon, the major identifier is specific to (say) a region, like a store location; and a minor 
is specific to a sub-region, like a department within a store, or another very specific location. The 
identifier is recognized by an app, which is programmed either to present a screen of information 
such as a map, merchandise description, or museum exhibit information, or to perform some other 
location-specific task. 

To broadcast an iBeacon: 

1. Select a node from the Node Selection Tree.  
2. Verify iBeacon is checked in the View window under Beacon Configuration.  
3. Click Get to receive current configuration settings in the iBeacon Configuration Panel. 
4. Type in UUID (universally unique identifier) and a Major and Minor pair.  
5. Select beacon transmission power (Tx Power) in the drop-down menu. 
6. Enter a value for dBm at 1m. This represents the average received signal strength at 1m 

from the device. 
7. Type in broadcast interval in the Interval (ms) field. To disable beacon broadcasting, set the 

period to 0.  
8. Click Set to program the device to broadcast the iBeacon. 
9. Verify configuration was programmed successfully by clicking Get. Configuration settings 

should match the values you entered. 

 

For more information on iBeacon, visit https://developer.apple.com/ibeacon. 

https://developers.google.com/beacons/eddystone
https://developer.apple.com/ibeacon
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ALTBEACON CONFIGURATION  

AltBeacon is an open source alternative to iBeacon. 

To broadcast an Altbeacon: 

1. Select a node from the Node Selection Tree.  
2. Verify AltBeacon is checked in the View window under Beacon Configuration.  
3. Click Get to receive current configuration settings in the AltBeacon Configuration Panel. 
4. Type in Beacon ID, Mfg ID and Mfg Data.  
5. Enter a value for dBm at 1m. This represents the average received signal strength at 1m 

from the device. 
6. Type in broadcast interval in the Interval (ms) field. To disable beacon broadcasting, set the 

period to 0.  
7. Click Set to program the device to broadcast the AltBeacon. 
8. Verify configuration was programmed successfully by clicking Get. Configuration settings 

should match the values you entered. 

For more information on AltBeacon, visit http://altbeacon.org/ 

  

http://altbeacon.org/
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7 LOG TAB 

The Log Tab allows the user to access Real Time and historic data for each device. Use the Node 
Selection Tree to choose the device you would like to see information on. 

   

7.1 REAL TIME DATA 

GalaXi devices provide real time operating/monitoring data from the multiple sensors integrated 
into their memory banks. This data is not stored as history data on the device. It is simply a 
continuous real time reading of the sensors.  
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7.2 HISTORICAL DATA 

Power Cycles. When the device detects a power-on event, the 
power cycle counter will be incremented. 

LED Cycles. When the LED is driven from off (intensity = 0) to on 
(intensity ≥ 0.1%), the LED power cycle counter will be 
incremented. Any LED off to on event, both power cycles and 
commanded intensity from off to on , will cause the LED power 
cycle to be incremented. 

Operation Hours. The counter will be incremented for each hour that the LED is turned on and 
operating (i.e., intensity ≥ 0.1%). The maximum value for operating hours 
that can be recorded is 200,000, which corresponds to ~23 years of 
operation. 

Lux-Hours (Sensors Only). The counter captures the accumulated 
exposure of light detected by the lux sensor over time.  

Illumination Level (lux) x Number of hours = lux hours 

The Lux-Hour counter is resettable through the Reset History… button. 

Sensor Hours (Sensors Only). Counter displays the amount of time elapsed since the Lux-Hour 
counter was last reset.  

PCB Hours (Sensors Only). The counter will be incremented for each hour that the sensor board is 
turned on and operating. This value cannot be reset.  

Reset History… (Sensors Only). Click to bring up the Reset History 
window. Click the box corresponding to the historical data to be reset on 
the XIS. If the XIS history data is pasword protected, enter the password 
in the Password field, otherwise leave the field blank.   

Change Password (Sensors Only). Click to display the Change Password 
screen that allows the user to protect the historical data on the XIS sensor. 
If you are setting up a password for the first time, leave the Old Password 
field blank. Click OK to save the new password.  
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Device Information. Click to show the Device Information window which displays Xicato and OEM 
programed data in addition to Group and Scene number assignments for the device.   

 

Intensity Histogram 

XIMs, XIDs, and XCGs maintain a history of maximum LED intensity over each second that the device 
is operating (i.e., VIN ≥ 40.0V) whether the LED is turned on or turned off (i.e., intensity = 0). After 
each second, the maximum intensity of the LED during that second is recorded and the 
corresponding intensity range bucket is incremented. 

This data can be used to build a histogram of the LED Intensity.  
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Temperature Histogram (Tc & PCB) 

In addition to intensity, XIMs, XIDs, and XCGs maintain a history of operating temperature of the LED 
over each hour of use that the LED is turned on and operating (i.e., intensity ≥ 0.1%). The LED 
temperature recorded corresponds to the Tc measurement point of the XIM. This data can be used 
to build a histogram of the LED operating temperature. 

After an hour in which the LED is operating elapses, the maximum temperature of the LED during 
that hour is recorded and the corresponding temperature range bucket is incremented. 

 

Humidity Histogram 

The XIS maintains a history of relative humidity over each second of use that the sensor PCB is 
operating. This data can be used to build a histogram of the relative humidity. Every second, the 
humidity of the XIS is recorded and the corresponding humidity range bucket is incremented. 
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7.3 DEVICE GRAPHS AND LOG DATA 

INDIVIDUAL DEVICE 

To save all device data collected since the Control Panel was launched, click the 
Save Log Data button. An excel file containing intensity, temperature, voltage, 
and ripple voltage data with respect to time will be created. The file will be 
saved in the directory the Control Panel is installed in and can be found in the 
C:\Xicato_Control_Panel_V1_6\logs folder. Each individual Device file will be 
named [Network Name]\[Device ID].csv 

Click Real Time Graph to view a graph of the log data collected since the application was launched. 
Clicking Clear Log Data erases the cached log data and clears the Real Time Graph display.  

 

ALL DEVICES 

To view the Real Time temperature graphs of all devices simultaneously, select either LED Temp 
Graph or PCB Temp Graph. To save this data to a log file, click Save All Temp Data. Two files, 
ledTemperatureHistory.csv and pcbTemperatureHistory.csv, will be created in the 
C:\Xicato_Control_Panel_V1_6\logs directory. 

Click Clear All Log Data to clear cached log data and the temperature graphs.  
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If a Sensor is selected in the Log tab, click Temperature Graph, Humidity Graph, or Lux Graph to 
graph all respective sensors inputs simultaneously. 
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8 LIGHT SETUP TAB 

  

8.1 BLE LIGHT CONFIGURATION 

LIGHT LEVEL LIMITS 

Use these fields to adjust minimum and maximum intensity levels from BLE commands. These limits 
only apply to intensity commands sent through Bluetooth communication. They do not apply to 1-
10V or DALI commands sent through the device’s control wires.  

Note that max level (%) should not be confused with the max flux (%) setting. Maximum & minimum 
intensity levels (%) can be modified in the Xicato Control Panel but the max flux (%) setting can only 
be set using the OEM’s XCT (Xicato Configuration Tool). The programmed max flux (%) can be found 
in either the Device Information window in the Log tab or by hovering over the device name in the 
Dashboard tab.  
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The following examples describe the differences between Max Flux and Max Level. 

• 2000lm XIM module with Max. Flux (%) set to 80%.  
At 100% intensity, XIM will emit 1600lm. XIM will follow 
standard dimming curve from 0% to 100%. This 
cannot be modified in the field. 
 

• 2000lm XIM Module, with Max. Flux (%) set to 80% 
& Max. Level (%) set to 90%. 
The XIM module’s maximum flux is set to 80% and the 
maximum intensity level is capped at 90%. The unit 
will emit 1440lm (90% of 1600lm) at this level. The XIM 
will only follow the dimming curve from 0% to 90%. 
The maximum (and minimum) level can be modified 
in the field using the XIM Control Panel; however, Max 
Flux (%) values cannot be modified without the use of 
an XCT tool.  

FADE CONFIGURATION 

Choose between logarithmic or linear dimming. Linear dimming recommended when XIM is 
targeting a specific lux in sensor response mode. If Fade Smoothing is enabled, the module fade 
rate will slow down as intensity approaches target intensity. 

POWER ON CONFIGURATION  

Wired. Intensity at power on is determined by wired control line. 

Last. Intensity at power on is controlled by whichever system (wired or wireless) set the last intensity 
command. 

Fixed. User may enter any value from 0-100%. Device will power on to that intensity regardless of 
whichever system set the last intensity command. 
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8.2 DALI WIRED CONTROL CONFIGURATION (DALI XIMS ONLY) 

DALI LIGHT LEVEL LIMITS 

Similar to BLE Light Level Limits.  These fields adjust minimum and 
maximum intensity levels from DALI commands. Max level (%) 
should not be confused with max flux (%) setting. 

DALI FADE CONFIGURATION 

The XIM supports both the logarithmic dimming curve that is 
specified in IEC 62386-102 and the linear dimming curve that is 
specified in IEC 62386-207. The logarithmic curve is programmed 
as the default configuration. 

The XIM supports all of the fade times and fade rates defined in 
section 9.5 of IEC 62386-102. In addition, when the fade time index 
value (X) is set to 0, the XIM will support fast fade times as defined 
in IEC 62386-207 

The XIM supports a maximum fade rate of 1 DALI step per millisecond. This is the fade rate that is 
used for any DALI command that requires an immediate response without fading (e.g., OFF, STEP UP, 
STEP DOWN, RECALL MAX LEVEL, RECALL MIN LEVEL, etc.). In addition, this is the default fade rate 
factory programmed into the XIM, and it is the fade rate used if both the Fade Time and Fast Fade 
Time indexes are set to 0. 

DALI POWER ON CONFIGURATION 

Fixed. User may enter any value from 0-100%. Device will power on to that intensity 
regardless of whichever system set the last intensity command. 

Last. Intensity at Power On is the intensity when the device last powered down.  

DALI BUS FAILURE CONFIGURATION 

If enabled, the XIM will go to this intensity if it detects a DALI bus failure.  
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8.3 1-10V WIRED LIGHT CONFIGURATION (1-10V XIM AND XIDS ONLY) 

CONTROL MODES 

Control. In this mode the light is controlled by 
whichever system (wired or wireless) set the last 
intensity command. This is the default operating 
mode. 

Limit. In this mode, the 0-10V interface sets the 
upper intensity limit. The BLE interface can then 
adjust the intensity to any value up to the limit. If an 
intensity value above the limit is sent over the BLE 
interface, the XIM will simply stop at the limit. If the 
intensity limit is adjusted down the lamp intensity 
will track it. If the intensity limit is adjusted up there will be no change in the lamp intensity. 

Control & Limit. When both boxes are checked, the 0-10V sets the upper intensity limit, but 
if the 0-10V control is adjusted the light will track the adjustment (up or down). 

Disabled. 1-10V controls wires are disabled and any dimmers or switches connected have 
no effect on the module. 

Input Curve. Select the dimmer type used on the control wires. 

Intensity at 1V. Enter intensity value when voltage across control wires is 1V. This is typically the 
minimum intensity before module turns off. 

Limit Intensity. Displays current intensity limit based on the 1-10V voltage. Only used when Limit or 
Control & Limit are set as the Control Mode.  

8.4 LED LOAD RESET (XID ONLY) 

Click the Reset button to reset to the forward voltage (VF) reference of the XID. Use this function 
when modifying the load on the output of the XID (e.g. when swapping a COB for another with a 
different VF). Resetting the LED Load will also clear a LCG (Load Change) status event on the Control 
Panel Dashboard.  
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8.5 EMERGENCY LIGHTING CONFIGURATION 

Xicato XIMs and XIDs can be programmed to respond to input voltages between 36V and 40V 
(voltage from battery backup) and transition into Emergency Mode (EM). During this time, devices 
will broadcast their status but will not respond to light control commands. Devices will resume 
normal operation when input voltage goes above 41V. 

Important message for XID users - Forward voltage of the light source must be lower than the 
input voltage provided by the emergency battery backup for Emergency Mode to work properly. EM 
can only be enabled on XIDs configured for 48V operation.  

Enabled/Disabled Mode. Use the drop down menu to choose to enable or disable Emergency 
Mode (EM). Disabling EM will turn off the light source completely if input voltage falls below 40V. 

Intensity (%). Choose the intensity level the XIM or XID should go to in Emergency Mode.  

Enter Duration (s). Specify the amount of time the XIM or XID needs to be within the 36V-40V input 
voltage range before EM mode is triggered. Note that if this time period is too short, the device may 
go into EM during power up as the device transitions through this range to 48V.    
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9 GROUPS TAB 

 

9.1 CREATING A GROUP 

All group creation, modification, and removal may be achieved through the Group Management 
Window. To open the Group Management Window, either: 

1. Right-click the name of the Secure Network and select “Group Names…” in the Node 
Selection tree.  

 
 

2. Or, right-click “Groups” under a Secure Network and select “Group Names…” in the Node 
Selection tree. 
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ADD A GROUP IN THE GROUP MANAGEMENT WINDOW 

In the Group Management Window, 

1. Enter the Number of the Group you would like to add. Numbers must be unique within the 
same Secure Network.  

2. Provide a Name for the Group you would like to add. 
3. Click Add. The Group will be added to the list to the left. 
4. Use the arrow buttons to manage the order in which the Groups are listed. 

REMOVE A GROUP FROM THE GROUP MANAGEMENT WINDOW 

1. Select and highlight the Group from the Group list. 
2. Click Remove. 

Any devices assigned to the removed Group will remain associated with that Group. The Group 
name will be removed from Group list and Node Selection Tree. 

EXPORT GROUP LIST FROM THE GROUP MANAGEMENT WINDOW 

1. Click Export…. 
2. Choose a location to place the Group or Scene list and click Save. Default file name is 

SavedGroups.txt.  You may choose to rename the file if you wish. 

IMPORT GROUP LIST FROM THE GROUP MANAGEMENT WINDOW 

1. Click Import… 
2. Navigate to the directory where the network list is located. 

Highlight Text file and click Open. 
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ADD A GROUP FROM THE NODE SELECTION TREE 

Alternatively, Groups can also be added directly into the Node Selection Tree if Show All Groups is 
enabled. To add a group: 

1. First, verify that Show All Groups is enabled in the View menu of the menu toolbar. When 
enabled, all groups will be shown in the Nodes tree. When disabled (default setting), only 
subscribed groups are shown.  
 

 
 

2. Select the Network the new group will be a member of from the Node Selection Tree.  
3. Right-click the Network name and select Add Group… (The "Add Group..." menu item will be 

only be available if View->Show All Groups is enabled. See Step 1.) 

 
 

4. Select and enter the Group Number and Group Name of the new group you want to create. 
If you would like to clone an already existing group, select that group in the Clone Group 
drop-down menu; otherwise, select None. The created group is then added to the Node 
Selection Tree.  
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9.2 ASSINGING DEVICES TO GROUPS 

ASSIGNING MULTIPLE GROUPS TO A SINGLE DEVICE 

1. Select an individual light from the Node Selection Tree. The Single Device Group 
Configuration screen will appear in the Groups tab. 

 

 
2. Click Get to see which groups the current device is a member of. The Available Groups 

column lists groups the device is not a member of. The Device Groups column shows 
groups the device is a member of. 
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3. To assign or unassign groups for the device, click a group to highlight it and use the arrow 
buttons to move the group between columns. The double-arrow will move the entire 
column of groups. When finished, click Set to program the device and update which groups 
the device is a member of. After update, click Get to verify programming was successful. 

 

ASSIGNING MULTIPLE DEVICES TO A SINGLE GROUP 

1. Select a group from the Node Selection Tree. The Multi-Device Group Configuration 
screen will appear in the Groups tab. 
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2. Click Get to see what devices are currently assigned to the Group.  

  

3. Highlight devices and use the arrow buttons to move devices from the Devices Not In 
Group column to the Devices In Group column (or vice versa). 

 

4.  An asterisk (*) will appear next to moved devices to indicate that the groups these devices 
are assigned to has been modified. Click Set to program the device and update which 
devices are now members of the selected group. After updating, click Get to verify 
programming was successful. 
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10 SCENES TAB 

 

10.1 CREATING A SCENE 

All scene creation, modification, and removal may be done through the Scene Management 
Window. To open the Scene Management Window, right-click the name of the Secure Network and 
select “Scene Names…” in the Node Selection tree.  

 

ADD A SCENE IN THE SCENE MANAGEMENT WINDOW 

In the Scene Management Window, 

1. Enter the Number of the Scene you would like to add. Numbers must be unique within the 
same Secure Network.  

2. Provide a Name for the Scene you would like to add. 
3. Click Add. The Scene will be added to the list to the left. 
4. Use the arrow buttons to manage the order in which the Scenes are listed. 
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REMOVE A SCENE FROM THE SCENE MANAGEMENT WINDOW 

1. Select and highlight the Scene from the Scene Management list. 
2. Click Remove. 

Any devices assigned to the removed Scene will remain associated with that Scene. The Scene recall 
button for the removed scene will no longer be displayed in the Light Control tab. 

EXPORT SCENE LIST 

3. Click Export…. 
4. Choose a location to place the Group or Scene list and click Save. Default file name is 

SavedGroups.txt. or SavedScenes.txt.  You may choose to rename the file if you wish. 

IMPORT SCENE LIST 

3. Click Import… 
4. Navigate to the directory where the network list is located. 

Highlight Text file and click Open. 

10.2 ASSIGNING DEVICES TO SCENES 

1. Select the scene you would like to add devices to.  

 

2. Select a node or group of lights from the Node Selection Tree.  
3. Click Get to see what devices are currently assigned to the selected scene. The Control Panel 

will connect with each light in the group selected. 
4. Highlight devices and use the arrow buttons to move devices from the Devices Not in Scene 

list to Scene Dashboard.  
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5. The Intensity, Fade, and Delay columns are editable. Type in a value for each device. Click 
Show to preview the Scene. Click Set when finished to program the devices with the new 
scene settings.  Modified device rows will turn from blue to white indicating that device 
programing was successful.  

 
 

6. To recall the scene, navigate to the Light Control tab. A button for each available scene will 
be visible on the Scene Level Control pane. Click the scene button to recall the 
corresponding scene. 
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11 RESPONSE TAB 

11.1 FUNCTIONAL OVERVIEW 

The Sensor Intelligent Response Engine (SIRE) is a programmable state machine, where the user 
defines the transitions between states along with the associated action. A state transition is defined 
by the following: 

 To State: The state number that it is going to.  
o For example: 2 

 From State(s): One or more states that it can transition from.  
o For example: 0 and 1 

 Condition(s): The conditions that would trigger this state transition.  
o For example: {Motion Sensor Event OR Schedule Start Time}; {Button 1 Press}.  

 Action: The action to perform when the state transition occurs.  
o For example: direct intensity 1% with 1s fade; 100 lux with a slow response time. 

 

11.2 GENERAL RESPONSE PAGE SETUP 

 

For a much deeper in-depth review of the Sensor tab with examples, refer to the Xicato Sensor 
Programming Examples document located in the CP_Docs folder of your Control Panel directory. 
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12 LIGHT CONTROL TAB 

 

All buttons on the Light Control tab control either a single device or a group of lights. Use the Node 
Selection Tree to choose the single device or group of devices to control. 

DIM LEVEL CONTROL 

Use the mouse pointer to drag the slider to any intensity between 0-100%. When you release the 
slider, the device (or devices selected) will dim to that level over the fade time entered in the Fade 
Time field. You can also manually type in the desired intensity in the Intensity field. Press “Enter” on 
your keyboard to dim.  

If the master channel of a multi-channel device is choosen in the device drop-down menu, sliders for 
all sub-channels will be availiable.   
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QUICK CONTROL 
On. Dim the device(s) to the intensity displayed in the Intensity field of the Dim Level Control pane. 
Off. Dim the device(s) to off (0% intensity). 
Max Level. Dim the device(s) to their programed maximum intensity level. 
Min Level. Dim the device(s) to their programed minimum intensity level. 
Fade Time. Selecting any of the four quick control buttons will dim the device(s) over the fade time 
entered in the check box. 

 

SCENE LEVEL CONTROL 

Click the scene button to recall the corresponding scene. Fade times are determined by what is 
programmed into each device from the Scenes tab. When Fade Time is enabled, the fade time in the 
text box will be used for all devices when recalling a scene.  
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13 SECURE NETWORKS 

13.1 ABOUT SECURE NETWORKS 

Device security is managed in a similar way to a Wi-Fi network; users gain access to a network of 
secured modules by entering a Secure Network name (ID) and password (PW) into the application. 
Through a complex algorithm, the application converts the ID and PW into a 128-bit encryption key 
with which it encodes all future communication with that device. The presence of a network is never 
broadcasted. Unless you are told of the existence of a particular secure zone and given the Secure 
Network ID and PW, you will not be able to see any of the data or control any of the lights in that 
zone. 

Devices do not overlap networks. A device or sensor can only be Unsecured or in one Secure 
Network at a time. You can move a device between Secure Networks, but it will carry its Group and 
Scene numbers with it unless you delete the Groups and Scenes from the device. For more 
information on adding, removing, or transferring devices between networks, refer to the Device 
Setup tab section of this document.  

BY THE NUMBERS 

 The system supports over 4 billion (2^32) secure networks, each of which can support 
2^15 – 1 = 32,767 individual nodes, for a theoretical total of over 140 trillion nodes. 

 Each secure network can be configured with up to 16,383 groups and 65,535 scenes. 

13.2 RESETTING SECURE NETWORKS 

There is no way to wirelessly access a member of a Secure Network without the proper network ID 
and PW; therefore, Administrators must remember their IDs and passwords, or it will require 
physical (wired) access to the modules to reset the lights.  

Resetting XIM. With physical access to the module, it is possible to restore the XIM to an Unsecure 
state by physically touching pins 3 and 4 together for 5 seconds while the unit is powered. These 
pins are not used for normal operation – they are the two pins that are neither the power wires nor 
the wired communications wires. 

Resetting XID. With physical access to the driver, it is possible to restore the XID to an Unsecure 
state by inserting the end of a paper clip (or similar) into the hole on the bottom of the device 
closest to the output connector for 3 seconds while the device is powered. 
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13.4 SECURE NETWORK MANAGEMENT WINDOW 

To access the Secure Network Management window for your Site, right-click the Site name from 
the Node Selection Tree and select “Manage Networks…”  

 

ADDING A SECURE NETWORK 

1. Select Add… from the Secure Network Management window. 
2. Enter the Name and Password for the Secure Network. Both fields are case-sensitive. 

Password must be at least 6 characters. 
 

 
 

3. The pop-up box will have the "Compatible with <= 1.5.x" checkbox available, but unchecked. 
Leaving this box unchecked will use a new ID and key generation method than Networks, 
which were created in Xicato Control Panel versions 1.5.x and before. The previous ID and 
key generation method required the first four characters of the Network Name be unique 
(e.g Room 1 and Room 2 were not allowed). If you are adding a Network that was 
previously created from a Control Panel version 1.5.x or earlier, check this box. 
Otherwise, newly created networks should leave this option unchecked.  
 
Networks that are/were created with the old method will have an '*' appended to their name.  
 

Important! There is no way to wirelessly access a member of a Secure Network without the proper 
network ID name and password. Do not forget the credentials to the Secure Network you are 
creating!  

4. Click OK to create the Secure Network.  
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SECURE NETWORK LIST 

 After creating a Secure Network, the network will automatically be added to the Network List. All 
Devices that are assigned to the Secure Network will now be visible. Double-click the Network name 
to enable/disable each Network. Devices on disabled Networks will be removed from the Dashboard. 
To remove Unsecure Devices or public nodes, disable the Unsecured network.  

  

To add devices or nodes to a Secure Network, see Dashboard Tab. Individual devices and nodes 
cannot be assigned to multiple Secure Networks. 

REMOVING A SECURE NETWORK 

1. Select the network you wish to remove in the Network List in the Secure Network 
Management panel. 

2. Click Remove. 

The devices that were assigned to the removed Secure Network will still belong to that network; 
however, you will no longer be able to access or view any of the devices on that network until the 
network is added again.  

IMPORTING LEGACY SECURE NETWORK LIST 

1. Click Import Legacy… in the Secure Network Management window. 
2. Navigate to the directory where the network list is located. 
3. Highlight Text file and click Open. 

Also, note that Secure Networks can be imported when using the “Load Site” function from the File 
menu. 
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13.5 LOCAL NETWORK SETTINGS 

Access Local Network Settings by right-clicking the name of the Secure Network in the Node 
Selection Tree and selecting “Local Settings…”  

                          

Node ID. The Device ID of the Control Panel on the selected Secure Network. The Control Panel 
Device ID can be different from one network to another.  

Starting TTL. Messages sent from the Xicato Control Panel are retransmitted by relay nodes 
provided that the Time To Live (TTL) value is 2 or more. Enter the Time To Live value in the Starting 
TTL field. For more information on TTL and mesh networking, refer to the Device Relay and Mesh 
Networking section of this document (Device Setup Tab). 

Local Time ADV Interval (s). For purposes of scheduling, the Xicato Control Panel can broadcast the 
local time and day of week to all devices within range. To advertise the local time (time and date 
settings of your PC or Mac), enter a non-zero Local Time Advertising Interval value. 

 

To confirm a device is receiving the local time, select the device in the Node Selection Tree, navigate 
to the Response tab, and click Get All. The current time and day of the week will display in the 
Schedule panel.  
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14 CONTROL PANEL PREFERENCES 

To access the Preferences menu of the Xicato Control, select Edit > Preferences… in the main 
menu bar.  

  

14.1 APPEARANCE 

Tablet View. Uncheck this box to disable Tablet View. 
In Tablet View, the contact size of controls is increased 
to improve usability for tablet users. Disabling allows 
more content to be displayed. Enabling/disabling Tablet 
View requires an application restart to apply the change. 

Show Response Buttons. Enable to show individual Get/Set buttons on section of the Response Tab. 

Show Scene Button Numbers. When enabled, in the Light Control tab, the scene numbers will be 
included in the scene button labels.  

14.2 LOGGING 

Event Logging. Enable to log Control Panel application 
events. Log file can be used for debugging CP 
application issues. Files will be created and saved to the 
Control Panel directory in the Event_Logs folder 
(C:\Xicato_Control_Panel_V1_6\Event_Logs). The date 

and time of when the log file was created will be in the file name.  

Packet Logging. Enable to log BLE packets received and transmitted from the BluGiga BLE dongle. 
Log files will be created and saved to the Control Panel directory in the Packet_Logs folder 
(C:\Xicato_Control_Panel_V1_6\Packet_Logs). The date and time of when the log file was created will 
be in the file name.  

Hourly Logging. Enable to log device information hourly. Log files will be created and saved to the 
Control Panel directory in the Hourly_Logs folder (C:\Xicato_Control_Panel_V1_6\Hourly_Logs). File 
name will be <Network Name>_<Device ID>.  
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14.3 INDICATE (FLASH) CONFIGURATION 

Use this section to configure light indicator settings. To indicate (flash) a light, single-click the 
intensity column on the Dashboard Tab. The default configuration is set to flash the lights 3 times. 
When multiple users are commissioning a space, it is useful to have indicators unique to each user. 
For example, User A will flash their lights 3 times quickly while User B can flash their lights 4 times at 
a slower rate. This prevents the two users from accidentally mistaking their partner’s indicator as 
their own. 
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15 APPENDIX A - XIM PROTECTION 

15.1 OVER-TEMPERATURE PROTECTION 

LED luminaires are designed to operate within a specific ambient temperature range. Occasionally 
the ambient temperature will exceed the design temperature, for example, if insulation is 
unintentionally placed on or near the luminaire. Additionally, the thermal management system (e.g. 
heat sink) may get installed incorrectly, which could increase the LED module’s temperature above 
the recommended limit. In these cases, the performance of the electrical components (LEDs and 
driver electronics) is placed at risk. To address this risk, XIM features over-temperature protection. 

XIM contains a temperature sensor that monitors the Tc of the LEDs. If the temperature exceeds 
93°C, XIM’s integrated electronics reduce the intensity which then lowers both current and the 
temperature. The intensity is reduced to 85% of the commanded intensity over a period of 60 
seconds. If the temperature drops below 93°C, but stays above 85°C, XIM will maintain the intensity 
at the reduced level. If the temperature drops below 85°C, XIM will increase intensity back to 100% 
of the commanded intensity over a period of 60 seconds. The “Thermal Overload” diagram below 
illustrates this behavior. 

 

If the module temperature stays below 98°C, but stays above 93°C for 5 minutes, XIM will 
immediately limit the maximum intensity to 10%. The intensity limit will stay at 10% even if the 
temperature drops below 85°C. To remove the limit, the user must set the commanded intensity to 
0% (turn off the light) and the temperature must be below 93°C. Then, when the user sets the 
commanded intensity to above 0% (turns on the light), XIM will set the light to the commanded 
intensity (no reduction). A power cycle of XIM will also remove the limit. The “Thermal Overload 
Lockout” diagram below illustrates this behavior. 
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If at any time, the module temperature exceeds 98°C, XIM will immediately turn off the LEDs. The 
LEDs will stay off even if the temperature drops below 85°C. To turn on the LEDs again, the user 
must set the commanded intensity to 0% (turn off the light) and the temperature must be below 
93°C. Then, when the user sets the commanded intensity to above 0% (turns on the light), XIM will 
set the light to the commanded intensity (no reduction). A power cycle of XIM will also allow the LEDs 
to be turned on. The “Thermal Shut Down” diagram below illustrates this behavior. 

 

15.2 COLD-START PROTECTION 

If the temperature is below -20°C, the current draw from XIM could be greater than the specified 
maximum current. In order to prevent overloading the power supply, XIM reduces the current by 
reducing the LED intensity. 

If the temperature of the module is below -20°C, XIM will limit the maximum intensity to 50% until 
the temperature exceeds 0°C. During this time, if the commanded intensity is less than 50%, then 
XIM will set the LEDs to the commanded intensity. If the commanded intensity is greater than or 
equal to 50%, then XIM will set the LEDs to 50%. When the temperature exceeds 0°C, XIM will 
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increase the limit to 100% over a period of 16 seconds. If the commanded intensity is greater than 
50%, XIM will increase the LED intensity from 50% up until it reaches the commanded intensity. The 
“Cold-Start Protection” diagram below illustrates this behavior. 

 

15.3 POWER SUPPLY UNDER-VOLTAGE PROTECTION 

The input supply voltage must be above 41V in order for XIM to turn on the LEDs. If the input supply 
voltage drops below 38V, XIM will turn off. 

If the current draw on the power supply is greater than the power supply’s rating, the voltage may 
fluctuate between a voltage greater than 41V and a voltage less than 38V, which may cause XIM’s to 
flash. If XIM detects this voltage drop-out 5 times within 10 minutes, it will shut off. In order to reset 
XIM, the commanded intensity must be set to off then on, or the supply voltage must drop below 5V. 
If the power supply voltage drop-out is so severe that the voltage drops below 5V, XIM will flash 
continuously until the power supply is turned off. The “Under-Voltage Protection” diagram below 
illustrates this behavior. 
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15.4 LED ARRAY SHORT-CIRCUIT PROTECTION 

If there is a short circuit in the LED array assembly inside the module, it may be a safety risk. In this 
situation, XIM will shut off
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16 APPENDIX B – SENSOR SUPPORTED CONDITIONS 

Reference list of Sensor Conditions for use with the Control Panel Sensors tab. 

Category Name Condition Description 

Condition 
Modifiers 

AND AND 
Links multiple conditions. Value is true if both linked 
condition are true. 

OR OR 
Links multiple conditions. Value is true if either linked 
conditions is true. 

Always True True Condition is always true. 

State Time 

In State Duration Less 
Than 

StateTime < t Time in State < t seconds. Maximum time is 4 hours. 

In State Duration 
Greater Than 

StateTime > t Time in State > t seconds. Maximum time is 4 hours. 

Switches & 
Buttons 

Button Press Bx.y Press Button Press Event for Switch x Button y 

Button Release Bx.y Release Button Release Event for Switch x Button y 

Long Button Press 
Bx.y PressTime 

> t 
Button Press Time > (or <) t seconds for Switch x Button 
y 

Long Button Release 
Bx.y 

ReleaseTime < 
t 

Button Release Time > (or <) t seconds for Switch x 
Button y 

All Button Events 
Timeout 

B& Time > t 
Button Event > t seconds for all enabled Switch Buttons. 
Maximum time is 4 hours 

Lux 
Lux Less Than Lx.y < l Lux sensor x, sub-sensor y value is less than l lux 

Lux Greater Than Lx.y > l Lux sensor x, sub-sensor y value is greater than l lux 

Light 
Control 

Light Control Event LC Evt 
Direct Light Control (Direct Intensity or Scene Recall) 
Event 

Light Control Timeout LC Time > t 
Last Direct Light Control > (or <) t seconds ago. 
Maximum time is 4 hours. 

Motion 

Motion Event Mx.y Evt 
Motion Detection Event for Motion Sensor x, sub-sensor 
y 

Motion Timeout Mx.y Time > t 
Last Motion Detection > (or <) t seconds ago for Motion 
Sensor x, sub-sensor y. Maximum time is 4 hours. 

All Motion Timeout M& Time > t 
Last Motion Detection > t seconds ago for All Motion 
Sensors. Maximum time is 4 hours. 

Schedule Schedule Active T0 Active 

Current day is enabled and current time is between the 
defined start and end time. If start time is greater than 
end time (e.g. Start = 17:00:00, End = 08:00:00), then it 
will stay active into the next day. Only the day that the 
event starts needs to be enabled (e.g. if it starts Monday 
night and ends Tuesday morning, then only Monday 
should be enabled) 
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Schedule Inactive T0 Inactive Opposite of T0 Active 

Schedule Start T0 Start 
Schedule has started Event. The current time has just 
reached the start time. 

Schedule End T0 End 
Schedule has ended Event. The current time has just 
reached the end time. 

Time Not Available TNone 
Current time is unknown. Condition is true when no 
local time advertisement has been received.  

Intensity 

Tracking Intensity 
Value Less Than  

Y0 < i Device Y0 intensity value is less than i percent. 

Tracking Intensity 
Value Greater Than 

Y0 > i Device Y0 intensity value is greater than i percent. 

Tracking Intensity 
Received Time Less 

Than 
Y0 Time < t 

Last light status or light change packet from device Y0 
received < t seconds ago.  

Tracking Intensity 
Received Time Less 

Than 
Y0 Time > t 

Last light status or light change packet from device Y0 
received > t seconds ago.  
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